
Introduction to Excel
 

What is Microsoft Excel? 
Excel is a spreadsheet (SS) program that provides the user with the ability to organize data, do 
basic/advanced calculations, do what-if analysis, graph data, create professional reports, publish info to 
the Web, access real-time data from the Web. We will do all of these things through the four major parts 
of the Excel application: 

•      Worksheets: where we will enter, calculate, manipulate and analyze data.
•      Charts: to represent our data pictorially.
•      Databases: to manage the data. We can search, sort and select.
•      Web Support: to save data in HTML format.

Let's begin by going to the Start menu and launching the Excel application. Your screen should look 
something like the following (only much larger):

As with all Office 2007 applications, Excel's functiuonality is divided into Ribbons or Tabs.  To use a 
particular bit of functionality, select the appropriate Tab from the top.  Depending on the version of Excel 
that you are using, the menu bar and toolbar options might look a little different. Also, even though the 
Mac and Windows versions of Excel are pretty much compatible, there are differences between the UIs 
(User Interfaces) in the Mac and the Windows environments.

The round Office Icon in the top left acts at the File Menu, allowing you to Open, Close, Save, and 
Print the Spreadsheet file.
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Workbook
When you first start Excel, it opens up with a new workbook called Book1. This workbook contains three 
worksheets by default called Sheet1, Sheet2, and Sheet3. This is similar to having a notebook with many 
sheets of paper.  

 Can you rename the worksheets? 
Right click and select Rename to rename a worksheet. 

 Can you add more worksheets? 
You can add many more (right click and select Insert). 

Worksheet 
Worksheets consist of a grid or rows and columns. Each worksheet consists of cells, which are the basic 
building blocks of every worksheet.
 
A cell is referred to by its unique address or cell reference. The cell address is the Column letter and the 
Row number, for example D13.
 
Q1: What is an active cell and how do we know which cell is currently active? 
Answer: ________________________________________________________________

________________________________________________________________________

________________________________________________________________________

Cells
You can enter various types of information into cells in various ways. The simplest type of information is 
text, which you just enter by selecting the cell and typing the text.
 
You can also enter numbers (or values) by typing in any of the number characters and acceptable 
symbols. Valid number symbols are = - ( ) , / . $ % E e. Do not put any spaces in a number or Excel will 
interpret it as text.

Formulas
Formulas are a different type of data that you can enter into the cell. A formula begins with an equal sign 
followed by a well-formed expression. If the equal sign is missing, chances are that the cell data will be 
interpreted as text unless a simple number is typed in.
 
Q2: If we place the formula =3+9/3-1 into cell A1, what value gets displayed? Why? 
Answer: ________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________



________________________________________________________________________

Q3: Excel contains several binary arithmetic operators. What is a binary operator and what are the five 
most common binary operators? 
Answer: ________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
 
Q4: What is operator precedence and how does it apply to the above binary operators listed in the 
previous question? 
Answer: ________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

Q5: What is the value of each of the following formulas? 
 

•      =2+4/2  
__________________
•      =4/0 
__________________
•      =0/4 
__________________
•      =2*3+5/2 
__________________
•      =2*/3 
__________________
•      =2*-1

 



Q6: Consider the formula =2+3+6. When we talk about the operator associativity of an operator, what do 
we mean and how does it apply to this formula?
Answer: ________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

Important concepts: Operator Precedence and Operator Associativity. 

Operator Precedence: ______________________________________________________

________________________________________________________________________

________________________________________________________________________

Operator Associativity: ____________________________________________________

________________________________________________________________________

________________________________________________________________________

Cell References
Not only can numbers be placed in cell formulas, cell references can be used in cell formulas. 
 
Q7: What does the following formula mean? =A1+2 
Answer: ________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

Problem 1
Place the values 10, -3 and 22 in the cells A1, A2, and A3 respectively. In cell, A4, write the formula to 
find the average of the values in cells A1 to A3. Then change the value in cell A2, and the value in cell A4 
should be modified as soon as you hit return. 



Cell references in formulas can be relative or absolute. 
 

•      Relative references: refer to cell references in formulas in relation to the cell that contains the 
formula. This is what we’ve been using so far.
•      Absolute references: refer to cells in their absolute or fixed position. 

Named Cells
You can name a cell rather than 
reference it through its address. 
This allows us to give meaningful 
names to values for use in 
formulas.

Problem: Place your age in cell G1. Using the Formulas Tab, Define Name of that cell to MyAge.  In 
cell G2, write the number of years left you have in college, name that cell YearsLeft.  In cell G3 write a 
formula to determine your age when you graduate college.

Write that formula here: ______________________________________________________________

Filling
Typically, when creating a SS, you want to get some pattern going so that you can do some kind of fill 
either down or right. When filling, Excel adjusts the cell references in formulas based on whether they are 
relative or absolute. 
 
Let’s go back to our worksheet. Right now A4 calculates the sum of the values in A1, A2 and A3. What if 
we want B4 to calculate the sum of the values in B1, B2 and B3, and C4 to calculate the sum of the values 
in C1, C2 and C3, and so on till column E. Enter the values that we want to sum in B1, B2, B3, C1, C2, 
etc.
 
Now, since the formula in A4 uses relative cell references, you can just select that cell, and drag from the 
bottom right hand corner to the right. This is called filling.
 
What you’ll notice is that B4 now contains the formula =B1+B2+B3.
 
Question: How can you view the formula in a cell?
 
An alternative to dragging is to copy A4 and paste it in C4. This is also filling



Problem 2.1
You are just starting college and you have calculated your expenses for your freshmen year as described 
below. You would now like to project what your expenses will be for each category for the next three 
years assuming that there will be a 6% increase in all expenses.

Category      Expenses
Clothes 540
Entertainment 725
Miscellaneous 355
Room & Board 3480
Tuition & Books 5150
 
How would you proceed? Name your spreadsheet “College”
 
Assume that you now want to find out what your total expenses for each year will be. What would you 
need to add?
 
Now suppose that you would like to see what your expenses will be if the increase was 7% or 8%. What 
changes would we have to make to the spreadsheet (SS)? 

Formatting
Excel provides some advanced formatting capabilities (on the Home tab) to make your spreadsheet look 
more professional. The one that you should start using now is the cell formatting option. You get to this 
option by selecting the cell or cells you want to format and going through the Home tab and using the 
Number group. From here you can choose the type of number in your cell. The ones you are interested in 
now are the currency and percentage options.  The Styles group contains predefined formatting options.
 
From now on, any numbers that you have in your worksheet should be formatted appropriately.

Absolute Cell Reference
What is the difference between a relative and absolute reference again? 
 
Absolute references are specified using a $, so for example, a cell reference of $A$1 references cell A1 
and any subsequent copy of the cell reference into another cell still produces $A$1. 
 
It is also possible to make just the row or column reference absolute as follows: $A1 or A$1. 
 
Question: How do $A1 and A$1 differ from $A$1? 

Problem 2.2
Modify the college expenses SS so that the user just has to change the yearly percent increase and the rest 
of the SS is updated with the proper values. 



Error messages
Excel has several error messages that you should be aware of and the main ones are: 
 

•      # - A ##### error value occurs when the cell contains a number, date, or time that is wider than the 
cell or when the cell contains a date and/or time formula that produces a negative result. 
•      #DIV/0! - The #DIV/0! error value occurs when a formula divides by 0 (zero). 
•      #na - No information is available for the calculation you want to perform. 
•      #NAME? - The #NAME? error value occurs when Microsoft Excel doesn't recognize text in a 
formula. 
•      #NULL! - The #NULL! error value occurs when you specify an intersection of two areas that do 
not intersect. 
•      #REF! - The #REF! error value occurs when a cell reference is not valid. 
•      #VALUE! - The #VALUE! error value occurs when the wrong type of argument or operand is 
used, or if the Formula AutoCorrect feature cannot correct the formula. 

Problem 3 
Name your spreadsheet “Meteorology”

A meteorology class found the average weekly temperature for each week of each month for one year. 
The data follows. You are to find each of the following using a SS: 
 

1. The average monthly temperature for each month. 
2. The highest and lowest monthly averages using two functions we have not discussed yet: 

maximum and minimum. See if you can use the help feature to figure this out. 
 

Month  Week1  Week2  Week3  Week4 
jan    33     36     29     31
feb    37     32     39     38
mar    43     47     38     45
apr    49     51     53     50
may    52     55     54     58
jun    56     62     61     60
jul    65     69     73     70
aug    72     74     68     69
sep    67     66     64     60
oct    63     65     60     59
nov    46     42     45     40
dec    38     35     36     35
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